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About This Guide 

Introduction 

As part of regular business operations, subscribers may return a Cisco® set-top box 
(STB) to you; for example, when they move to a new city or if the STB is not 
functioning properly. Upon receiving the STB and before returning it to a subscriber, 
you will want to ensure that the STB is in optimal working condition and that it is 
returned to its original factory condition.  

To make certain that a returned STB is ready for another subscriber, Cisco has 
developed the Screen and Clean application. This application ensures that the 
components of the STB are functioning properly and restores all factory default 
settings. 

The Screen and Clean application runs various tests, selected by the operating 
technician, and delivers results in real-time right to your desktop. This tool is a 
diagnostic tool; therefore, if any test fails, you can rerun the test or refer to your 
normal troubleshooting procedures. 
 
 

Purpose 

This guide teaches you how to use the Screen and Clean application on returned 
STBs so that they can be distributed with factory default settings to new subscribers. 
You will learn how to set up your test system to use the Screen and Clean 
application, as well as how to install the application on your PC. 
 

Scope 

This guide provides the following information and instructions: 

 System requirements 

 System setup 

 Screen and Clean installation and testing procedures 

 Test descriptions 
 

Audience 

This guide is written for system operators and technicians who are responsible for 
restoring an STB to its original factory condition, as well as verifying that the STB 
functions properly. 
 
 



 

About This Guide 

vi 4040318 Rev B 

Document Version 

This is the second formal release of this document. In addition to minor text and 
graphic changes, the following table provides the technical changes to this 
document.  

Description See Topic 

Updated images for improved user interface Throughout document 

Clarified several test parameters and updated 
the results example 

Running the Screen and Clean 
Application (on page 26) 
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Introduction 

This overview of the Screen and Clean application introduces you to 
the purpose and key features of this application. This section also 
introduces the components of the Screen and Clean main screen. The 
components include menu options and toolbar buttons. 

The Screen and Clean application is a Windows-based application that 
runs on a personal computer (PC) and communicates with a Cisco STB 
that has been returned by a subscriber.  

The purpose for using the Screen and Clean application includes the 
following functions:   

 Verifying the operation of an STB 

 Resetting the non-volatile memory (NVM) to clear out the 
previous subscriber’s settings 

 Reformatting the hard drive to remove any user content 
(applicable models only) 

 Providing minimal tracking of any failed tests  
 

 

 

 

1 Chapter 1 
Welcome to the Screen and 
Clean Application 

In This Chapter 
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Introducing Screen and Clean 

Features 

The Screen and Clean application includes the following features: 

 No testing of software is necessary; all tests are designed to find hardware faults 

 The test process requires minimal interaction by the operator 

 The Screen and Clean application does not interfere with normal subscriber 
operation 

 Immediate test results are displayed in the user interface  
 

Benefits 

The Screen and Clean application provides you with the following benefits: 

 Verifies the operation of the STB 

 Tests major sub-systems of the STB, such as digital and analog video, audio 
connections, and front panel buttons 

 Provides minimal tracking of any failed tests 

 Restores the STB to the factory default state 
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Application Overview 
This section describes the components of the Screen and Clean user interface, 
including the main menu and the toolbar. 

Note:  For information about how to set up your system to run the Screen and Clean 
application, go to System Setup. For information on how to run the Screen and Clean 
application, go to Running the Screen and Clean Application.  
 

Screen and Clean Window 

The Cisco Screen and Clean window opens immediately after you launch the 
application. The main Screen and Clean window consists of the following 
components:  

 Main Menu—Contains various menus that allow you to access commands  

 Toolbar—Contains icons that provide quick access to commonly used features  

 Technician Information—Includes text boxes that allow you to input 
information about the test site, technician, STB product, and any special 
situation, or circumstances (Notes)  

 Test Control Panel—Includes a list of automated, user, and destructive tests  

 Test Results—Provides an area where results are reported for each completed 
test 
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The following example shows the Cisco Systems Screen and Clean main window. 

 
 

Main Menu 

This section provides descriptions of the Main Menu options. The Main Menu 
options include the following menus:  

 File  

 Edit 

 View  

 Help  
 

File Menu Command Functions 

File Menu Command Function 

Run Tests Runs the tests that you selected in the main 
control panel 

Stop Tests Stops the tests 

Note: If a test is in progress, it will complete 
before the remaining tests are stopped. 
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File Menu Command Function 

Save to DB Saves the test results to the database (DB) 

Notes: 

 This option is only valid after a test session 
has been completed.  

 This option is not enabled if Auto Save to 
DB is enabled.  

Print Prints a copy of the test results to your default 
printer 

Print Preview Allows you to view how the test results will 
appear when they are printed 

Print Setup Allows you to specify the printer and printer 
connection 

Exit Closes the Screen and Clean application 
 

 

Edit Menu Command Functions 

Edit Menu Command Function 

Copy All Output to 
Clipboard 

Copies all output from the test results 
window to the clipboard 

Notes: 

 You do not need to select any text prior to 
executing this command.  

 You can also right-click your mouse 
button in the test results area and select 
Copy All to Clipboard to place a copy of 
the output on the clipboard.  

Settings Allows you to customize testing parameters 
for the test site 
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View Menu Command Functions 

View Menu 
Command 

Function 

Toolbar Allows you to view or hide the toolbar 

Status Bar Allows you to view or hide the status bar 

Clear Output on Run Allows you to enable an auto-clear feature 
that clears the output from the test results 
area each time a new test is run 

Note: If you do not wish to enable this 
feature, you can manually clear the output 
from the test results area, when desired. To do 
so, select Clear Output from the View menu 
or right-click your mouse button in the test 
results section and select Clear Output.  

Clear Output Allows you to clear the output from the test 
results area 

Note: You can also right-click your mouse 
button in the test results area and select Clear 

Output to delete output from this area. 

Auto Save to DB If selected, all output from the test results 
window is automatically saved to the 
database when the test session is complete 

Notes:  

 When enabled, the manual Save to DB 
option is disabled.  

 If this feature is not checked, you must 
manually save output to the database 
using the Save to DB command or the 
Save Results button. 

 Once the test results have been saved, you 
cannot save them again. 

DB Records Allows you to display all records saved to the 
database with the option of deleting them as 
well 
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Help Menu Command Functions 

Help Menu 
Command 

Function 

Help Topics Allows you to view an index of help topics for 
Screen and Clean 

About Screen and 
Clean 

Provides copyright and version information 

 
 

Toolbar Functions 

The toolbar within the Screen and Clean application allows you to quickly access 
commonly used features as shown in the following diagram: 

 

Icon Command Function 

 

Print Prints a copy of the test results 

 

Print Preview Allows you to view how the test results will 
appear when they are printed 

 

Save Results Saves the test results to the database 

Note: You can only save test results once after 
each test session.  

 

Run Tests Runs the tests selected in the main control 
panel 

 

Stop Tests Stops the tests 

Notes:  

 This icon is only visible when the tests are 
running. 

 If a test is in progress, it will complete, but 
no other tests will begin. 

 

Help Displays a list of help topics 



 

Chapter 1    Welcome to the Screen and Clean Application  
 
 

8 4040318 Rev B 

 
 

Technician Information 

When you first open the Screen and Clean application, you will enter the 
appropriate information in the Site Information section. The fields in these sections 
are text-only fields.  

You will also enter the appropriate information (for example, MAC address) from 
the labels on the STB into the Product Information area of the window, typically 
using a barcode scanner. 

Important: You must include an entry for each field, except the Notes field, to 
successfully run a test session. 

Notes:  

 If you enter a serial number, hardware revision, MAC address, or CA serial 
number incorrectly in the Product Information area, the tests for those values 
(Automated Tests area of the control panel) will fail. When a test fails, the correct 
value is displayed in the test results area and the incorrect value is highlighted in 
yellow. You should check the values marked on the set-top in case there is a 
labeling error. 

 The MAC address can either be the set-top MAC address or the set-top's cable 
modem MAC address, depending on the set-top model. However, it must match 
the label on the set-top. If both MAC labels are present, use the set-top MAC 
address. 

 Once you enter information into any of these fields, it is saved for future tests.  
 

Test Control Panel 

The main test control panel includes the following test types:  

 Auto Tests—Tests that do not require you to perform any functions. These tests 
are automatically run by the application 

 User Tests—Tests that require you to perform a function (for example, pressing 
front-panel keys for the Front Panel Keys test)  

 Destructive Tests—Tests that remove any owner-configured data (for example, 
the NVM Reset Test returns the STB to factory defaults) 

Note: You can select any number of tests to run simultaneously.  
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Test Results 

The test results section includes information regarding the outcome of each test, 
including the date and time that the tests were started and finished.  

 The starting date and time is shown at the beginning of the test results.  

 The ending date and time is shown at the end of the test results.  

 The duration of the entire test session is also included at the end of the test 
results.  

Most tests display a Passed (text is green) or Failed result (text is red), while others 
also list actual values; for example, Network ID (value is blue). All test results can be 
printed to your printer or saved to the database.  

If a test yields a pass result, the STB successfully passed the requirements for the 
individual test. If all of the tests in a test run pass, an overall “Passed” test result is 
shown in the test results window.  

Example: 

Overall Test Results 
Passed 

If a test fails, the STB did not pass the requirements of the individual test. If any 
number of tests fail during a test run, an overall Failed test result is shown in the test 
results window. 

Example: 

Overall Test Results 
Failed: 2 Tests 

If a failure is reported and details are available, a question mark icon ( ) activates 
next to the Failed result in the main control panel. Click this icon to view why an 
individual test failed.  
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Example: If the Front Panel Keys test did not pass, the following dialog may appear 
when you click the question mark icon. 

 

Important: If a test fails, you can run the test again. If the test continues to fail, 
follow your normal procedures for further troubleshooting. 
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Introduction 

This section describes and illustrates the typical setup for connecting 
PCs to a mini-headend environment. This section also describes the 
procedures for operating and installing the Screen and Clean software 
application on your PC.  
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System Requirements 
This section outlines the software and hardware requirements that are needed to use 
the Screen and Clean application.  
 

Software 

The following software is required on the PC that is running the Screen and Clean 
application: 

 Cisco Screen and Clean Application 

 Microsoft Windows XP or Windows 7 

 Open Database Connectivity (ODBC) Data Source  
 

Hardware 

To successfully test STBs with the Screen and Clean application, the system or test 
operator is required to have the following equipment for their system environment: 

 An STB  

 Rc5 remote control  

 Universal Broadband Router Cable Modem Termination System (UBR CMTS)  

 Mini-headend  

 Television  

- SCART connector (serial input)  

- Standard-definition TV (SDTV)  

- High-definition TV (HDTV) with HDMI™  

- IEC 60958 optical input (digital audio)  

 Cable TV signal  

 MPEG2 stream generator/player, preferably having three transport stream 
outputs that contain different content  

 Three QAM modulators  

 One CMTS for DOCSIS® communication (256-QAM is recommended)  

 RF combining network for the three QAMs and CMTS  

 Two-way distribution network for multiple test bench requirements  

 RF attenuator for each test bench to change drop levels  
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 PC connected to the CMTS network with the Screen and Clean application 
installed  

 Printer  

 CA test cards1  

 Peripheral device  

 Burn-in racks  

 Assorted cable leads (including an SCART cable, RCA cable, RF cable, power 
cable, IR cable, RJ-45 cabling, and USB connector cable)   

1 The Smartcard test requires a valid, functioning, non-blacklisted card. 
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Test Configuration 

Overview 

This section describes how to connect an STB to your PC and your headend system. 
The connections described within this section will ensure that each Screen and Clean 
test operates properly.  
 

Connecting the STB 

Depending on the STB type and test station setup, there are two configuration 
options:  

1 Direct Ethernet connection. 

2 Connection via CMTS.  

These two options are illustrated next in the section. 
 

Direct Ethernet Connection 

To communicate with the STB, the PC needs to be connected using Ethernet directly 
to the STB as illustrated in the following example. 
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Connection via CMTS 

To communicate with the STB, the PC needs to be connected using Ethernet to the 
same network as the UBR CMTS as illustrated in the following example. 

 

Complete the following steps to connect the STB to a PC and a test station. 

1 Using an RF cable, connect the STB to the RF connection located on your mini-
headend system.  

2 Using a SCART cable, HDMI cable, power cable, or IR cable, connect the STB to 
the SDTV or HDTV, as needed. 

Note: These cables are needed for specific tests. Refer to Screen and Clean Test 
Descriptions (on page 35), to determine where the cables are connected and 
which cable is needed for each test. 
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Installing the Screen and Clean Application 
This section describes the procedures for installing the Screen and Clean application 
onto your PC.  

This section also includes instructions for setting up a data source. A data source 
provides the connection information that enables you to communicate with the 
Screen and Clean database.  
 

Complete the following steps to install the Screen and Clean application on your PC.  

1 Insert the Screen and Clean CD into the CD-ROM drive on your PC. The Screen 
and Clean Welcome window opens. Alternatively, double-click the setup.exe file 
from the installation folder. 

2 Click Next. The Select Installation Folder window opens. 

3 Select one of the following: 

 Everyone 

 Just Me 

4 Complete one of the following options:  

a Click Next to install the application into the default folder destination.  

b Click Browse to install the application into a different folder.  

Result: The Confirm Installation window opens. 

5 Review your installation settings.  

6 Are your settings correct?  

 If yes, click Next.  

 If no, click Back and correct your settings by repeating steps 3 through 5, as 
needed.  

7 When the Installation Complete window opens, click Close to exit.  

Results:   

 The Screen and Clean application is successfully installed on your PC.  

 The Screen and Clean program group is added to the Start menu (Start > 

Programs > Cisco SPVTG >Screen & Clean > Screen & Clean) and contains 
shortcuts to the application and this guide.  

 A Screen & Clean icon is placed on your desktop for quick access to the 
application.  
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Configuring the Data Source 
Open DataBase Connectivity (ODBC) is a programming interface that provides a 
common language for Windows-based applications to access databases on a 
network.  

The Screen and Clean application requires you to manually set up an ODBC data 
source so that you can save test results to the database.  

Note: If you have already set up the ODBC data source for an earlier version of 
Screen and Clean, you do not have to set it up again.  
 

Configuring the Data Source for Windows XP 

The following instructions will guide you through setting up an ODBC data source 
name that points to the Screen and Clean database if you are running Windows XP.  

1 From your desktop, click the Start menu and then select the following sub 
commands: 

Settings > Control Panel > Administrative Tools > Data Sources (ODBC). The 
ODBC Data Source Administrator window opens.  
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2 Click the File DSN tab, and then click Add. The Create New Data Source 
window opens.  

 

3 Select Microsoft Access Driver (*mdb) and click Next. A second Create New 
Data Source window opens.  

4 In the Data Source Name box, type ScreenClean.dsn for the data source, and 
click Next.  

Important:  You must use ScreenClean.dsn for the data source name. If you use a 
different name, test results will not be saved to the database.  

Result: An overview of the Screen and Clean data source is shown in the next 
window. 

5 Click Finish. The ODBC Microsoft Access Setup window opens.  
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6 Click Select. The Select Database window opens.  

 

7 Navigate to the C:\Program Files\Cisco SPVTG\Screen and Clean\DB 
directory and select ScreenClean.mdb.  

8 Click OK. The ODBC Microsoft Access Setup window opens and displays the 
database path where the ScreenClean.mdb data source is located.  

 

9 Click OK. The Select Database window closes and the ScreenClean.mdb data 
source is inserted into the ODBC Data Source Administrator window. 

10 Click OK.  
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Configuring the Data Source for Windows 7 

The following instructions will guide you through setting up an ODBC data source 
name that points to the Screen and Clean database if you are running Windows 7.  

1 From your desktop, click the Start menu, type the command shown below into 
the Run menu. 

 

2 Click OK. 

Result: The ODBC Data Source Administrator window opens with the User DSN 
tab in the forefront.  

 

3 Click the File DSN tab 
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4 Click Add. The ODBC Data Source Administrator window refreshes.  

 

5 Select DB and click Add. A Create New Data Source window opens. 

6 Select Microsoft Access Driver (*mdb) and click Next. A second Create New 
Data Source window opens.  

 

7 In the Data Source Name box, type ScreenClean.dsn for the data source, and 
then click Next.  

Important: You must use ScreenClean.dsn for the data source name. If you use a 
different name, test results will not be saved to the database.  
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Result: An overview of the Screen and Clean data source is shown in the next 
window. 

 

8 Click Finish. The ODBC Microsoft Access Setup window opens.  

9 Click Select. The Select Database window opens.  

 

10 Navigate to the C:\Program Files (x86)\Cisco SPVTG\Screen and Clean\DB 
directory and select ScreenClean.mdb.  
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11 Click OK. The ODBC Microsoft Access Setup window opens and displays the 
database path where the ScreenClean.mdb data source is located.  

 

12 Click OK. The Select Database window closes and the ScreenClean.mdb data 
source is inserted into the ODBC Data Source Administrator window. 

13 Click OK.  
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Introduction 

This section describes how to run automated, user, and destructive 
tests on an STB using the Screen and Clean application. This section 
also includes the procedures for starting up an STB.  

Note: The STBs can only be tested one at a time.  

For a complete description of each type of test, go to Screen and Clean 
Test Descriptions (on page 35). 
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Running the Screen and Clean Application 
This section describes how to run the Screen and Clean application and how to start 
up the STB. 

These procedures assume that you have successfully connected the STB to the host 
computer and a TV. If you have not yet connected your system, refer to System 
Setup. 
 

Important: These procedures outline the basic steps to run the Screen and Clean 
application; they do not describe each test. Please refer to Screen and Clean Test 
Descriptions (on page 35) for information about each test. 

1 Insert the power input to the STB. 

2 Press and hold the right arrow (  ) and the up arrow (  ) buttons at the same 
time for at least 10 seconds.  

3 Release the buttons. After a few seconds, the TV startup screen appears.  

 

4 Did the Screen and Clean graphic appear?.  

 If yes, the STB has successfully booted into Screen and Clean mode. 

 If no, repeat steps 1 through 3.  

5 Wait for the STB IP address to appear in the IP Address field. This address 
indicates that the STB is ready to communicate with the PC.  



 

 
 Running the Screen and Clean Application 

 

4040318 Rev B 27 
 

6 Double-click the Screen & Clean icon on your desktop. 

7 Is this the first time you are accessing the Screen and Clean application? 

 If yes, a "Tuning parameters are not valid." dialog similar to the following 
opens. 

 

 If no, the Screen and Clean window opens. Go to step 14.  
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8 Click OK. The Edit Settings window opens.  

 

9 In Tuning Parameters, enter the following information: 

 The low, mid, and high frequency parameters for your test site, as needed. 

 The frequency, modulation mode, and symbol rate that match your test 
streams. 

Note: The frequency value must be between 100,000,000 Hz and 860,000,000 Hz.  
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10 In A/V Test Parameters, enter or select the following information: 

 Enter the video, audio, and PCR PID values for each of the low, mid, and 
high frequencies. 

 Select the video and audio formats, H.264 and AC3, if applicable to your 
chosen PIDs. 

 Adjust the Frequency for A/V Tests selection, as needed.  

Note: The PID values must be between 1 and 8191.  

11 In Tuner Test Parameters, adjust the values as needed.  

12 Click Save. A dialog opens and asks you to confirm the changes that you made.  

13 Click OK. The Screen and Clean window opens.  

 

14 In Site Information, enter the appropriate information in the following fields: 

 Customer 

 ID/Location 

 Technician Name (first and last name)  

Important: Each of these fields must include an entry before you attempt to run a 
test.  

Note: All data that you provide in this section is automatically saved in these 
fields until you change them.  
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15 In Product Information, enter the values for the following fields:  

 Set-top IP—Must be manually entered to run the Screen and Clean 
application 

 Model—Select the STB model from the drop-down menu 

 Part No.—Automatically inserted by the system after you select the model 

 Serial No.—Located on the bottom label of the STB being tested 

 H/W Rev—Located on the bottom label of the STB being tested  

 MAC Addr—Located on the bottom label of the STB being tested 

 CA Serial No.—Located on the bottom label of the STB being tested  

Important: Each of these fields must include an entry before you attempt to 
run a test.  

Notes:  

– The serial number, hardware revision, MAC address, and CA serial 
number values should be on labels attached to the STB. If one of these 
entries is entered incorrectly, the tests for those values (Automated Tests 
area of the main control panel) will fail. When this test fails, the correct 
value is displayed in the test results area in red and the incorrect value 
you entered is highlighted in yellow.  

– All data that you provide in this section is automatically saved in these 
fields until you change them.  

16 From the Notes section, enter any text that is necessary to describe the testing 
situation (for example, user complaint or issue).  

Notes:  

 An entry in this field is not required.  

 This text field is limited to 255 characters and is not specific to any parameter.  

17 Select the tests that you want to run by selecting the check box located to the left 
of each test in the Automated Tests, User Tests, and Destructive Tests areas of 
the main control panel.  

Notes:   

 The tests in the Automated Tests area do not require any user interaction.  

 The tests in the User Tests area require user interaction (for example, 
pressing front-panel keys for the Front Panel Keys test).  

 The Destructive Tests will result in all original owner data/configuration 
being erased from the STB. These are usually run as the last step in the Screen 
and Clean process. 
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18 Click File > Run tests, or click Run Tests  from the toolbar to begin testing the 
STB. The results of each test are shown in the lower right portion of the 
application window. 

  

19 Click File > Save to DB or click Save Results  to save the results to the 
database.  

Notes:   

 Each set of test results can only be saved to the database one time.  

 If you have enabled the Auto Save to DB feature located in the View menu, 
you do not need to manually save the test results. The test results are 
automatically saved to the database after the test run completes.  

20 Click File > Print or click Print  to print the results.  
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Note: To see a preview of the printed copy, click File > Print Preview or click 

Print Preview .  

 

21 Do you want to run another test?  

 If yes, initiate a new test on the same STB or a different STB, and then repeat 
steps 15 through 20, as needed  

 If no, click File > Exit. The Screen and Clean application closes.  
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Introduction 

This section provides a brief description of each test in the Screen and 
Clean application that can be run on the STB. The test descriptions 
include the purpose of the test, as well as the possible test results. 

 

 

 

4 Chapter 4 
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Auto Tests 
This section describes each automated test type. Automated tests do not require 
operator involvement; therefore, the output will indicate when these tests have 
completed. 

Automated tests include the following test types: 

 Serial Number (on page 37) 

 Hardware Revision (on page 37) 

 MAC Address (on page 37) 

 CA Serial Number (on page 38) 

 HDD Serial Number (on page 38) 

 Network ID (on page 39) 

 ETI (on page 39) 

 Cable Modem (on page 40) 

 CPU (on page 40) 

 DRAM (on page 41) 

 Flash CRC (on page 41) 

 USB (on page 42) 

 Ethernet (on page 42) 

 Tuner (on page 43) 
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Serial Number 

A unique number assigned to an STB and used for identification purposes.  

This test is always run by default.  

Purpose: The Serial Number test verifies the serial number for a specific STB.  

Results: The correct serial number appears in the test results area.  

Example:   

Serial Number Test Results 

SABKNRGWQ 

Passed  
 

Hardware Revision 

The hardware (H/W) revision number is the hardware version number for the STB.  

This test is always run by default.  

Purpose: The Hardware Revision test verifies the hardware version number for the 
STB.  

Results: The correct hardware revision number appears in the test results area.  

Example: 

Hardware Revision Test Results  

8.2 

Passed  
 

MAC Address 

The MAC address is the unique physical address for the STB.  

This test is always run by default.  

Purpose: The MAC address test verifies the MAC address for the STB.  

Results: The correct MAC address appears in the test results area.  

Example:   

MAC Address Test Results 

00:01:E6:68:9B:E5  

Passed  
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CA Serial Number 

CA provides the encryption and conditional access services in the system.  

The CA serial number is the serial number for the CA software that is currently 
loaded on the STB.  

Purpose: The CA serial number test verifies the serial number for the headend 
software.  

Results: The CA serial number appears in the test results area.  

Example:  

CA Serial Number Test Results:  

00 0006 5536 47  

Passed  
 

HDD Serial Number 

The HDD Serial Number is the hard disk drive unique number for the STB.  

This test is always run by default. 

Purpose: The HDD Serial Number test verifies the hard drive serial number for the 
STB. 

Results: The correct hard drive serial number appears in the test results area. 

Example: 

HDD Serial Number Test Results: 

Serial: 5VX10EN 

Model: ST31000322CS 

Firmware Rev: CA13 

Passed 
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Network ID 

The Network ID is a unique identifier that the STB uses to obtain its network data 
(for example, channel line-up).  

This test is always run by default.  

Note: If this value is cleared after running the NVM Reset test, the new Network ID 
value will not be read or displayed until the STB has been rebooted.  

Purpose: The Network ID test verifies the value that the STB uses to obtain its 
network data.  

Results: The Network ID is a numeric number that appears in the test results area.  

Example:   

Network ID Test Results:  

41053  

Passed  
 

ETI 

The elapsed time indicator (ETI) is the total amount of time that an STB has been in 
use since it left the factory.  

The ETI is not reset and is updated every 24 hours. If the STB reboots prior to 
running for a continuous 24 hours, the ETI value will not increment.  

This test is always run by default.  

Purpose: The ETI test reports the amount of time (in days) that the STB has been in 
use since it left the factory.  

Example:   

ETI Test Results: 

70 days  

Passed  
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Cable Modem 

The Cable Modem test checks various DOCSIS parameters: CMTS MAC address, 
upstream and downstream power levels, downstream signal-to-noise ratio, 
downstream frequency, and operational state for the STB.  

With the exception of the downstream frequency, if any of the parameters are 
outside the specified limits the test fails. The downstream frequency is provided for 
information only.  

Purpose: Provides verification that the Cable Modem is operating correctly. The CM 
parameters appear in the test results area. 

Results: 

 Passed—The CM is functioning properly. 

 Failed—The CM is not functioning properly. 

Example:  

Cable Modem Test Results: 

CMTS: 00:d0:ba:77:03:54  Pass 

US Level: 36.3 dBmV  Pass 

DS Level: -10.0 dBmV  Pass 

DS S/N: 34.3 dB  Pass 

DS Freq: 586750000Hz 

State: operational(12)  Pass 

Passed 
 

CPU 

The CPU is the main processing device within the STB. Currently, only one 
processor is available in the STB; therefore, the CPU must be functional for testing to 
occur. 

Purpose: The CPU test verifies whether or not the CPU is functioning properly. 

Results:  

 Passed—The CPU is functioning properly.  

 Failed—The CPU is not functioning properly.  

Example:  

CPU Test Results:  

Passed  
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DRAM 

The dynamic random access memory (DRAM) is checked by writing a test pattern to 
the usable DRAM, and then reading the DRAM to confirm that the expected pattern 
exists.  

Purpose: The DRAM test verifies whether or not the DRAM is functioning properly.  

Results:   

 Passed—The DRAM is functioning properly.  

 Failed—The DRAM is not functioning properly.  

Example:   

DRAM Test Results:  

Passed  
 

Flash CRC 

After you start up the STB, the bootloader calculates the cyclic redundancy check 
(CRC) of the flash image and compares this value to the one stored in the flash 
memory. These values must match for the STB to function properly.  

Purpose: The Flash CRC test verifies the CRC that is calculated for the flash image 
matches the value stored in flash memory. 

Results:   

 Passed—The CRC for the flash image is valid.  

 Failed—The CRC for the flash image is not valid. 

Example:  

Flash CRC Test Results  

Passed  
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USB 

The USB test is used to test a USB port. 

Important: Depending on the features of the STB, the Screen and Clean application 
can test multiple USB ports. 

Purpose: The USB test verifies whether or not the USB port is functioning properly. 

Results: 

 Passed—The USB port is functioning properly. 

 Failed—The USB port is not functioning properly. 

Example: 

USB Test Results: 

Mass Storage Device 

Passed 
 

Ethernet 

The Ethernet test is used to test the Ethernet port. 

Purpose: The Ethernet test verifies whether or not the Ethernet port is functioning 
properly. 

Results: 

 Passed—The Ethernet port is functioning properly. 

 Failed—The Ethernet port is not functioning properly. 

Example: 

Ethernet Test Results 

Passed 
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Tuner 

Each Tuner test tests a single tuner within the STB and reports frequency-related 
information for that tuner module.  

Important: Depending on the features of the STB, the Screen and Clean application 
can test up to three tuners. 

Purpose: The tuner tests verify that the frequency-related parameters on the STB are 
within an acceptable operating range.  

Results: The results section includes the values for a low-, mid-, and high-frequency 
test. The results of these frequency tests yield one of the following results:  

 Passed—The parameters for the tuner are within an acceptable range.  

 Failed—The parameters for the tuner are not within an acceptable range.  

Example:    

Tuner 1 Test Results  

Low Frequency Test… 

Tuner Locked Status: Locked  

Frequency: 419000000 Hz  

Signal Level: 5 dB Pass  

S/N: 32 dB Pass  

BER: 0.000e+000 (000000000000) Pass   

 

Mid Frequency Test… 

Tuner Locked Status: Locked 

Frequency: 519000000 Hz  

Signal Level: 5 dB Pass  

S/N: 32 dB Pass  

BER: 0.000e+000 (000000000000) Pass   

 

High Frequency Test…  

Tuner Locked Status: Locked  

Frequency: 619000000 Hz   

Signal Level: 5dB Pass 

S/N: 32 dB Pass  

BER: 0.000e+000 (0.000000000000) Pass  

Passed  
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User Tests 
User tests require your involvement (for example, to press the front-panel keys). You 
then respond to questions prompted by the Screen and Clean application. The 
response to these questions determines the outcome of each test.  

User tests include the following test types:  

 Smart Card (on page 45)  

 Remote Control (on page 45)  

 Front Panel Keys (on page 46)  

 LED Display (on page 47)  

 SCART (on page 48)  

 HDMI (on page 48)  

 Optical Audio (on page 49)  
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Smart Card 

The Smart Card slot is usually located on the back panel of the STB and is labeled 
SMARTCARD.  

To perform this test, you must insert a Smart Card if one is not inserted in the 
SMARTCARD slot or remove a Smart Card that is already inserted in the 
SMARTCARD slot.  

Purpose: The Smart Card test verifies that the SMARTCARD slot on the STB is 
functioning properly.  

Results:  

 Passed—The Smart Card connection port is working properly.  

 Failed—The Smart Card connection port is not working properly.  

Example:   

Smart Card Test Results:  

Passed  
 

Remote Control 

The IR receiver is located on the front panel of the STB and receives signals from the 
remote control. 

When the test begins, point the remote control towards the STB IR receiver, and then 
press keys 1 and 2 on the remote control when prompted by the Screen and Clean 
application.  

Purpose: The Remote Control test verifies that the IR receiver on the STB is receiving 
a signal from the remote control.  

Results:   

 Passed—The STB received the signal from the remote control; therefore, the IR 
receiver is working properly.  

 Failed—The STB did not receive the signal from the remote control; therefore, 
the IR receiver is not working properly. 

Example:   

Remote Control Test Results 

Key 1: Passed  

Key 2: Passed  

Passed  
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Front Panel Keys 

The STB includes front-panel keys that allow you to access functions and features on 
the STB.  

When the Front Panel Keys test begins, a test window opens and continues to 
display until one of the following conditions is met:  

 All keys have been pressed and successfully recognized by the STB.  

 One or more key presses were not recognized by the STB; and therefore, you 
click OK in response to the following statement: 

Press all indicated Front panel buttons ONCE, then Click OK.  

When the test begins, each front-panel key is shown as a red question mark button in 
the test window. Press each key on the front panel of the STB one time to verify that 
the key is working properly.  

 If the key is functioning properly, the key indicator in the Front Panel Buttons 
window changes to a green OK button.  

 If you press a key twice or if the key “bounces” and causes the application to 
detect multiple presses to be detected, the key indicator changes to a yellow X 
button.  

 If you do not press a key, or if there is a hardware failure, the key indicator for 
that key continues to display the red question mark button. In this case, you can 
try to repeat the key press; otherwise, you will need to click OK in response to 
the dialog box.  

Purpose: The Front Panel Keys test verifies that each front-panel key on the STB is 
functioning properly.  

Results:   

 Passed—All of the front panel keys are working properly.  

 Failed—One or more front panel keys are not working properly. A list of keys 
that are not functioning properly are provided in the test results area.  

Example:   

Front Panel Keys Test Results  

All Keys Passed  

Passed  
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LED Display 

The display panel on the front of the STB provides general status information.  

For example, if the ONLINE LED is illuminated, then the STB is successfully 
connected to the CMTS on the headend.  

When the LED Display test begins, a test window opens and continues to display 
until you click Yes or No in response to the following question:  

Are the front panel LEDs displaying the same pattern as the above display?  

Purpose: The LED Display test verifies that LEDs on the front panel of the STB are 
operating correctly.  

Results:   

 Passed—The LEDs on the STB match those on the Front Panel LEDs test window 
and are operating correctly.  

 Failed—The LEDs on the STB do not match those on the Front Panel LEDs test 
window and do not operate correctly. 

Example: 

LED Display Test Results:  

Passed  
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SCART 

The SCART connector is located on the back panel of the STB and is labeled SCART.  

To perform this test, you must connect a SCART cable from the TV to the STB.  

When the SCART test begins, video and audio is played using the SCART output. A 
dialog window opens and continues to display until you click Yes or No in response 
to the following question:  

Is video present on the TV?  

After responding to this question, another dialog window opens and continues to 
display until you click Yes or No in response to the following question: 

Is audio present on the TV?  

Purpose: The SCART test verifies that both audio and video on the SCART 
connector is working properly. 

Results:  

 Passed—The SCART connection port is working properly.  

 Failed—The SCART connection port is not working properly.  

Example:    

SCART Test Results  

Video: Pass  

Audio: Pass  

Passed  
 

HDMI 

The high-definition multimedia interface (HDMI) output connector is located on the 
back panel of the STB and is labeled HDMI.  

To perform this test, you must connect an HDMI cable from an HDTV to the STB.  

When the HDMI test begins, video and audio is played using the HDMI output. A 
dialog window opens and continues to display until you click Yes or No in response 
to the following question:  

Is video present on the TV?  

After responding to this question, another dialog window opens and continues to 
display until you click Yes or No in response to the following question: 

Is audio present on the TV?  
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Purpose: The HDMI test verifies that the digital audio and video on the HDMI 
output connector is working properly when the STB is connected to an HDTV.  

Results:   

 Passed—The HDMI connection port is working properly.  

 Failed—The HDMI connection port is not working properly. 

Example:    

HDMI Test Results: 

Video: Pass  

Audio: Pass  

Passed  
 

Optical Audio 

The optical audio output connector is located on the back panel of the STB and is 
labeled OPTICAL AUDIO.  

To perform this test, you must connect an optical cable from an audio receiver to the 
STB.  

When the optical audio output test begins, audio is played using the optical output. 
A dialog window opens and continues to display until you click Yes or No in 
response to the following question:  

Do you hear audio on the stereo speakers?   

Purpose:  The Optical Audio test verifies that the digital audio output connector is 
working properly when the STB is connected to an audio receiver using an optical 
cable connector. 

Results:   

 Passed—The optical audio output connection port is working properly.  

 Failed—The optical audio output connection port is not working properly.  

Example:   

Optical Audio Test Results:  

Audio: Pass  

Passed  
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Destructive Tests 
Destructive tests remove any owner-configured data (for example, the NVM Reset 
test returns the STB to factory defaults).  

Destructive tests include the following test types: 

 HDD (on page 50) 

 HDD Reformat (on page 51) 

 NVM Reset (on page 51) 
 

HDD 

The hard disk drive (HDD) is permanently mounted in the STB and can contain 
programs recorded by the previous subscriber. 

Important: On some STB models, this test may remove the file structure. Therefore, 
you should always select the HDD Reformat test to run after this test has completed. 

Purpose: The HDD test verifies the recording surface of the HDD to ensure that it 
has no defects. 

Results: 

 Passed—The recording surface on the hard drive has no defects. 

 Failed—The recording surface on the hard drive has defects. 

Example: 

HDD Test Results: 

Passed 
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HDD Reformat 

The HDD Reformat test clears the hard drive to remove any previously recorded 
programs.  

You should always run the HDD Reformat test after the HDD test has completed. 

Purpose: The HDD Reformat test clears the content of the HDD and sets up clean 
partitions on the HDD. 

Result: 

 Passed—The HDD was successfully reformatted. 

 Failed—The HDD was not successfully reformatted. 

Example: 

HDD Test Results: 

Passed 
 

NVM Reset 

The NVM Reset test clears out all of the data stored in non-volatile memory except 
those values that were set at the factory.  

All operating system, application site-specific, and user-specific data items are reset 
to their default values by their respective owners the next time the box is booted or 
the application is launched.  

Purpose: The NVM Reset test clears the NVM on the STB, and maintains all data in 
the NVM assigned at the factory.  

Results:   

 Passed—The NVM was successfully cleared.  

 Failed—The NVM was not successfully cleared.  

Example:   

NVM Factory Defaults Test Results: 

Passed  
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If You Have Questions 

If you have technical questions, call Cisco Services for assistance. 
Follow the menu options to speak with a service engineer. 

Access your company's extranet site to view or order additional 
technical publications. For accessing instructions, contact the 
representative who handles your account. Check your extranet site 
often as the information is updated frequently. 
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B 

bit rate 

The number of bits of information that can be transmitted over a channel in a given second 
(usually express in bits per second [bps]). 

 
C 

CPU 

Central processing unit. 
 

CRC 

Cyclic redundancy check. Error-checking technique. 
 
D 

DOCSIS 

Data over cable service interface specification. This specification defines interface 
requirements for cable modems involved in high-speed data distribution over cable television 
system networks. This standard was developed by CableLabs in North America and 
approved by the International Telecommunication Union (ITU). 

 

DRAM 

Dynamic random access memory. 
 

DVB 

- Short for Digital Video Broadcasting Project (DVB), DVB is an industry-led consortium of 
more than 260 broadcasters, manufacturers, network operators, and regulatory bodies and 
others in over 35 countries committed to designing global standards for the global delivery of 
digital television and data services.  

- DVB is also the name used to describe the various European systems for television, radio 
and data broadcasting in all areas of the world outside of North America. 

 
E 

Ethernet 

A type of network technology for local area networks; coaxial cable carries radio frequency 
signals between computers at a rate of 10 or 100 megabits per second.  

 
F 

flash memory (ROM) 

Nonvolatile storage that can be electrically erased and reprogrammed so that software images 

Glossary 
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can be stored, booted, and rewritten as necessary. 
 
H 

HDMI 

High definition media interface. A multi-pin connection port used to transfer uncompressed 
digital video with HDCP copy protection, while also having the capability to transmit multi-
channel audio. 

 
L 

LED 

light-emitting diode. Semiconductor device that converts electrical energy into light.  Status 
lights on hardware devices are typically LEDs. 

 
M 

MAC address 

Media Access Control address. A unique physical address embedded into a network device. 
Similar to a serial number. 

 

MPEG-2 

Intended for higher quality video-on-demand applications and runs at data rates between 4 
and 9 Mbps. 

 
N 

NVM 

non-volatile memory. Memory that holds its content when the device it is associated with is 
turned off. 

 
P 

PCR 

program clock reference. Used to synchronize audio and video in a program.  
 

PID 

packet/program identifier. A number assigned to MPEG transport packets to identify the 
contents of the data and the information stream to which they belong. The 13-bit PID number 
is assigned in the MPEG-2 transport packet headers. All packets from the same stream have 
the same PID number. 

 
R 

reboot 

The reloading of the operating system (OS) and application programs into the main memory 
or random access memory (RAM) of the system. 

 
S 

SCART 

SCART is a 21-pin connector plug found on most European electronics, such as televisions, 
VCR, and DVD players. SCART is also known as a Euroconnector. SCART supports stereo 
audio and analog video. 
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signal level 

The signal power or intensity at a specified point and with respect to a specified reference 
level. 

 
T 

tuner 

A hardware device that allows live video content, such as from cable or broadcast television, 
to display on a local host. 

 
U 

USB 

universal serial bus. A port on a PC or other device that provides connection to peripherals, 
such as CD-ROM drives, printers, modems, and keyboards. 

 





 

 

4040318 Rev B 59 
 

A 

Application Overview • 3 
Benefits • 2 
Features • 2 
Main Menu • 4 
Technician Information • 8 
Test Control Panel • 8 
Test Results • 9 
Toolbar Functions • 7 

C 

CA Serial Number • 38 
Cable Modem • 40 
CPU • 40 

D 

DRAM • 41 

E 

Ethernet • 42 
ETI • 39 

F 

Flash CRC • 41 
Front Panel Keys • 46 

H 

Hardware Revision • 37 
HDD • 50 
HDD Reformat • 51 
HDD Serial Number • 38 
HDMI • 48 

I 

Introducing Screen and Clean • 2 

L 

LED Display • 47 

M 

MAC Address • 37 

Main Menu Options • 4 
Edit Menu Command Functions • 5 
File Menu Command Functions • 4 
Help Menu Command Functions • 7 
Toolbar Functions • 7 
View Menu Command Functions • 6 

N 

Network ID • 39 
NVM Reset • 51 

O 

Optical Audio • 49 

R 

Remote Control • 45 

S 

SCART • 48 
Screen and Clean Test Descriptions • 35 

Auto tests • 36 
Destructive tests • 50 
User tests • 44 

Screen and Clean Tests 
Introducing • 2 
Main Menu Options • 4 

Serial Number • 37 
Smart Card • 45 
System Setup • 11 

Configuring the Data Source • 17 
Connecting the STB • 14 
Hardware • 12 
Installing Screen and Clean • 16 
Software • 12 
Test Configuration • 14 

Index 



 

Index 
 

60 4040318 Rev B 

T 

Testing • 25 
Using Screen and Clean • 26 

Tuner • 43 

U 

USB • 42 
 





 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Cisco Systems, Inc.  
5030 Sugarloaf Parkway, Box 465447 
Lawrenceville, GA 30042 

  678 277-1120 
800 722-2009 

www.cisco.com 

This document includes various trademarks of Cisco Systems, Inc. Please see the Notices 
section of this document for a list of the Cisco Systems, Inc. trademarks used in this 
document. 
Product and service availability are subject to change without notice. 

© 2011 Cisco and/or its affiliates. All rights reserved. 
December 2011     Printed in United States of America  

 
Part Number 4040318 Rev B 

 

 


